




RANCANGAN PELAJARAN TAHUNAN

ASAS SAINS KOMPUTER TINGKATAN 1 


	MINGGU
	STANDARD KANDUNGAN
	STANDARD PEMBELAJARAN
	CADANGAN AKTIVITI
	CATATAN

	BIDANG PEMBELAJARAN : 1.0 KONSEP ASAS PEMIKIRAN KOMPUTASIONAL
	

	MINGGU 1
KUMPULAN A

11 JANUARI – 15 JANUARI 2026
KUMPULAN B
12 JANUARI – 16 JANUARI 2026

	
	
	
	

	MINGGU 2
KUMPULAN A

18 JANUARI – 22 JANUARI 2026
KUMPULAN B
19 JANUARI – 23 JANUARI 2026

	1.1 AsasPemikiranKomputasional
	1.1.1 MenerangkanteknikLeraian

(Decomposition), PengecamanCorak

(Pattern Recognition), Peniskalaan

(Abstraction) danPengitlakan

(Generalisation) dalampemikiran

komputasionaluntukmenyelesaikan

masalah.
	Menyenaraikanempatteknikpenyelesaian

masalah yang terdapatdalampemikiran

komputasional.
Penyelesaianmasalahberdasarkansituasi yang diberimelaluiaktivitiberkumpulan
aktivitipermainanpemikirankomputasionalatastalian
http://games.thinkingmyself.com/
http://www.bbc.co.uk/education/guides/zqqfyrd/revision
	

	MINGGU 3
KUMPULAN A

25 JANUARI – 28 JANUARI 2026
KUMPULAN B
26 JANUARI – 29 JANUARI 2026

	
	1.1.2 Menyelesaikansesuatutugasan

menggunakanteknikleraiandan

menentukanlangkahsecaratertib.
	Contohsituasi:
Bagaimanamengasingkanstokbukubaru di perpustakaan
	

	MINGGU 4
KUMPULAN A

1 FEBRUARI – 5 FEBRUARI 2026
KUMPULAN B
2 FEBRUARI – 6 FEBRUARI 2026

	
	1.1.3 Mengesanunsurpersamaandan

perbezaanuntukpengecamancorak

dalamsesuatusituasi.
	Contohsituasi:
Doktormendiagnospesakit
	

	MINGGU 5
KUMPULAN A

8 FEBRUARI – 12 FEBRUARI 2026
KUMPULAN B
9 FEBRUARI – 13 FEBRUARI 2026

	
	1.1.4 Membuatkeputusanbagimenentukan

aspekpentingdalamsesuatu

permasalahan.
	Menghasilkan model atauprototaipterhadap

cadanganpenyelesaianmasalah yang ditemui.
Contoh : LawatanSambilBelajar
Pameran ICT
	

	MINGGU 6
KUMPULAN A

15 FEBRUARI – 19 FEBRUARI 2026
KUMPULAN B

16 FEBRUARI – 20 FEBRUARI 2026

	
	
	
	

	MINGGU 7
KUMPULAN A

22 FEBRUARI – 26 FEBRUARI 2026
KUMPULAN B
23 FEBRUARI – 27 FEBRUARI 2026

	
	1.1.5 Menentukanciri-cirikesamaandalam

sesuatupermasalahan.
	Memberijustifikasiteknikpenyelesaianterbaikberdasarkan model yang telahdihasilkan


	

	BIDANG PEMBELAJARAN : 2.0 PERWAKILAN DATA
	

	MINGGU 8
KUMPULAN A

1 MAC –  5 MAC 2026
KUMPULAN B
2 MAC –  6 MAC 2026
MINGGU 9
KUMPULAN A

8 MAC – 12 MAC  2026
KUMPULAN B
9 MAC – 13 MAC  2026

	2.1 Sistem

Nombor

Perduaan
	2.1.1 Mengenalpastinomborperduaandan

nomborperpuluhan.
	Permainankad binary
http://csunplugged.org/binary-numbers/
	

	
	
	2.1.2 Menukarnomborperduaankepada

nomborperpuluhan.
	Permainankad binary
http://csunplugged.org/binary-numbers/
	

	
	
	2.1.3 Menukarnomborperpuluhankepada

nomborperduaan.
	Permainankad binary
http://csunplugged.org/binary-numbers/
Rujukan : JadualAsasSepuluhdanPerduaan
	

	MINGGU 9
KUMPULAN A

8 MAC – 12 MAC  2026
KUMPULAN B
9 MAC – 13 MAC  2026

	
	2.1.4 Melakukanoperasitambahbagiduanilai

nomborperduaan.
	Penyelesaianmasalahoperasitambahdalamnomborperduaan
Rujukan : https://www.khanacademy.org/math/pre-algebra/applying-math-reasoning-topic/alternate-number-bases/v/binary-addition
	

	
	
	2.1.5 Melakukanoperasitolakbagiduanilai

nomborperduaan.


	Penyelesaianmasalahoperasitolakdalamnomborperduaan
Rujukan : https://www.khanacademy.org
	

	MINGGU 10
KUMPULAN A

15 MAC – 19 MAC 2026
KUMPULAN B
16 MAC – 20 MAC 2026

	
	2.1.6 Menggabungkankemahiranoperasi

tambahdanoperasitolaknombor

perduaandalammenterjemahaksara

pengekodan ASCII.
	Aktivitimenggunakanpapankekunciberdasarkanjadual ASCII:
1. Operasimatematik
2. Penukaranaksara
3. Mengejanamasendiri
	

	KUMPULAN A
20 MAC – 28 MAC 2026
KUMPULAN B
21 MAC – 29 MAC 2026

	CUTI PENGGAL 1 
	
	
	

	MINGGU 11
KUMPULAN A
29 MAC – 2 APRIL 2026
KUMPULAN B
30 MAC – 3 APRIL 2026

	2.2 Ukuran

Data
	2.2.1 Mengenalpasti unit ukuranbagiimej digital dan audio digital
	Demo manipulasiimej digital yang sama:
1. Zoom in
2. Zoom out
Memperdengarkanbeberapasampel audio digital dalamperisian Audacity  
	

	
	
	2.2.2 Membandingsaiz fail imej yang samadalam

pelbagai format melaluitunjukcara:

i. Bitmap (*.bmp)

ii. Joint Photographic Experts Group

(*.jpeg)

iii. Tagged Image File Format (*.tiff)

iv. Graphics Interchange Format (*.gif)
	MuridmelihatkualitiimejmenerusiperisianMs Paint berdasarkan format fail yang diberioleh guru:

i. Bitmap (*.bmp)

ii. Joint Photographic Experts Group

(*.jpeg)
iv. Graphics Interchange Format (*.gif

iii. Tagged Image File Format (*.tiff)

Muridperlumenyimpan (Save As) setiapimejmengikut format fail yang diberi.
	

	MINGGU 11
KUMPULAN A
29 MAC – 2 APRIL 2026
KUMPULAN B
30 MAC – 3 APRIL 2026

	
	2.2.3 Membandingkankualitidansaizimejapabila

kedalamanwarna (colour depth) danresolusi

bagiimejdikurangkan.
	Aktivitikumpulan (1):
1. Setiapkumpulandiberi 3 set penselwarna( 6batang, 
    12 batang, 24 batang)
2. Ahlikumpulankumpulandikehendakimewarna 3 set 
gambar (contohgambardaun) berdasarkantonawarna
    yang dipilih. Contoh  setwarnatonahijau.
3. Kesemua set gambardibandingkandarisegikepadatan
warna,tondankualiti.

Aktivitikumpulan (2):
1.Mewarnakan gambarmenggunakan 1 ton warnasahaja
   (mengikutkreativitimurid).
2. Bincangkanhasildapatandariaktiviti 1 danaktiviti 2
	

	MINGGU 13

KUMPULAN A

12 APRIL – 16 APRIL 2026
KUMPULAN B
13 APRIL – 17 APRIL 2026

	
	2.2.4 Menghubungkaitsaiz audio dengankadar

kedalaman bit (bitrates) bagi audio.
	Aktivitimenggunakanaplikasi Audacity
[image: image1.png]KTVt

Untuk mefihat atau menukar kadar bit serta persampelan
boleh dibuat dengan menggunakan perisian Audacity

1. Lancarkan apikasi Audacity. Kik File>Open... Piin
sat fai audio format * mp3.
D_Kik Edit > Preference

Untuk menukar Kadar persampelan, boleh diubah pada
Default Sample Rate.
5. Untuk menukar Kedalaman bit, Default Sample For-
mat
Kemudian Kik butang OK.
7. Setelah itu untuk menyimpan audio, Kik File>Export
Audio>taip nama fai>Save.





	

	MINGGU 14

KUMPULAN A

26 APRIL – 30 APRIL 2026
KUMPULAN B
27 APRIL – 1 MEI 2026

	
	2.2.5 Membandingkansaiz fail dankualitiuntuk

audio yang samabagi format yang berlainan

melaluitunjukcara:

i. wave (*.wav)

ii. MPEG Layer III (*.mp3)

iii.midi (*.mid)
	Muridmenukar format fail audio audio digital dalamperisian Audacity:
i. wave (*.wav)

ii. MPEG Layer III (*.mp3)

iii.midi (*.mid)
Memberijustifikasidanbandingkankualitibunyi (aktivitihands-on)  
	

	MINGGU 15
KUMPULAN A

3 MEI – 7 MEI 2026
KUMPULAN B
4 MEI – 8 MEI 2026

	
	2.2.6 Menghasilkanpenukaransaiz data dari bit ke

bait, kilobait, megabait, gigabaitdanterabait

bagi fail audio danimej.
	Muridmendapatkankoleksi fail imej digital pelbagaijulatsaizdaripadapelbagaisumberdanmenukarkansaiz fail-fail dalamunit yang berbezadalamsatujadual.Bukuteks ms62.
	

	BIDANG PEMBELAJARAN : 3.0 ALGORITMA
	

	MINGGU 16
KUMPULAN A

10 MEI – 14 MEI 2026
KUMPULAN B
11 MEI – 15 MEI 2026

	3.1 Pembangunan 
Algoritma
	3.1.1 Menulispseudokoddan
melukiscartaalirpelbagaipilihandalampenyelesaianmasalah. 


	Muridmengenal-pastialgoritma, menulispseudokoddanmelukiscartaalirdaricontohsituasi yang diberikancontoh

a) Pemberianhadiahkepadapelajar yang mendapatgred A sahajadalammatapelajaran ASK

b) Penentuangredmarkahujianmatapelajaran ASK samada A, B, C, D atau E.

c) PembeliantiketketamanTemanmengikutkategoriumurdanwarganegara.


	

	
	
	3.1.2 Menulispseudokoddan

melukiscartaalir yang melibatkanulangan. 
	Muridmengenal-pastialgoritma, menulispseudokoddanmelukiscartaalirdaricontohsituasi yang diberikancontoh

a) Memasukkan bola kedalamjaringdenganpeluangcubaan 5 kali

b) Memasukkan air denganmenggunakancawankedalambaldisehinggapenuh


	

	MINGGU 17
KUMPULAN A

17 MEI – 21 MEI  2026
KUMPULAN B
18 MEI – 22 MEI  2026

	PENTAKSIRAN BILIK DARJAH 1 / PENTAKSIRAN SUMATIF / UPSA
	
	
	

	KUMPULAN A

22 MEI – 6 JUN 2026
KUMPULAN B
23 MEI – 7 JUN 2026
	CUTI PERTENGAHAN TAHUN
	
	
	

	MINGGU 18
KUMPULAN A

7 JUN – 11 JUN 2026
KUMPULAN B
8 JUN – 12 JUN 2026

	
	3.1.3 Mengesanralatdaripada

pseudokoddancartaalirdalam

penyelesaianmasalah. 


	Mengesanralatpadapseudokoddancartaalir yang telahdibinaolehmurid lain.
	

	MINGGU 19
KUMPULAN A

14 JUN – 18 JUN 2026
KUMPULAN B
15 JUN – 19 JUN 2026

	
	3.1.4 Menghasilkanpseudokoddancartaalir yang melibatkan

gabunganpelbagaipilihandan

ulangan.


	Muridmenyediakancartaalirdanpseudokod yang sesuaibagimewakilisesuatualgoritma. 
	

	BIDANG PEMBELAJARAN : 4.0 KOD ARAHAN
	

	MINGGU 20
KUMPULAN A

21 JUN – 25 JUN 2026
KUMPULAN B
22 JUN – 26 JUN 2026

	4.1 

KodArahan
	4.1.1 Menggunakanpemboleh
ubahdan operatormatematikdalamaturcara yang dibangunkan. 


	MuridmenggunakanperisianStratch2.0 untukmembinasatuaturcarasesuatu formula matematiksepertimengira perimeter segiempatsamasisidenganmenggunakanpembolehubahdanoperasimatematik yang sesuai.
	

	MINGGU 21
KUMPULAN A

28 JUN – 2 JULAI 2026
KUMPULAN B
29 JUN – 3 JULAI 2026

	
	4.1.2 Menghasilkanaturcara yang melibatkanpenggunaanpelbagaipilihan. 


	MuridmenggunakanperisianStracth 2.0 untukmembinaaturcarayengmempunyaipengekodanjenispilihan :if, if..else, if else..if..else
	

	MINGGU 22
KUMPULAN A

5 JULAI – 9 JULAI 2026
KUMPULAN B
6 JULAI – 10 JULAI 2026

	
	4.1.3 Menghasilkanaturcara yang melibatkanpenggunaanulangan. 


	MuridmenggunakanperisianStracth 2.0 untukmembinaaturcarayengmempunyaipengekodanjenisulangan. Blok-bloksrukturulangandalamStracth 2.0:  forever, repeat, repeat until
	

	MINGGU 23
KUMPULAN A

12 JULAI – 16 JULAI 2026
KUMPULAN B
13 JULAI – 17 JULAI 2026

	
	4.1.4 Membangunkanaturcara yang melibatkanpenggunaanpelbagaipilihan, ulangan, pembolehubahdan operator matematik. 


	Muridmembangunkanaturcaradenganmenganalisismasalah, merekabentukaturcara, pengekodan, pengujiandanpenyahpepijatandandokumentasi.
	

	MINGGU 24
KUMPULAN A

19 JULAI –  23 JULAI 2026
KUMPULAN B
20 JULAI –  24 JULAI 2026

	
	4.1.5 Mengujiaturcaradanmembaikiralatpadakodarahan yang dihasilkan.


	Muridmengesanralatdanmembaikiralatdalampengaturcaraanstracth 2.0
	

	MINGGU 25
KUMPULAN A

26 JULAI – 30 JULAI 2026
KUMPULAN B
27 JULAI – 31 JULAI 2026

	4.2 

KodArahan

HTML
	4.2.1 Melakarpapanceritauntukmembinalamansesawang

yangmenggunakankodarahan HTML.


	Muridmelukispapancerita yang logikuntuklamansesawang yang hendakdibina.
	

	MINGGU 27
KUMPULAN A

9 OGOS –  13 OGOS 2026
KUMPULAN B
10 OGOS –  14 OGOS 2026

	
	4.2.2 Menggunakantags dalamaturcara HTML : 

<head>; <title>; <body>dan
<paragraph> .
	Muridmembina tags dalamaturcara HTML

SesiAmali: muridmembina tags dalamaturcara HTML

Rujukan: www.w3schools.com
Perisian yang dicadangkan: MS Word, Notepad, dll


	

	
	
	4.2.3 Menggunaparagraph headings dalamaturcara HTML yang dibina. 


	Muridmembinaparagraph headingsdalamaturcara HTML

SesiAmali: muridmembinaparagraph headingsdalamaturcara HTML


	

	MINGGU 27
KUMPULAN A

9 OGOS –  13 OGOS 2026
KUMPULAN B
10 OGOS –  14 OGOS 2026

	
	4.2.4 Menggunakanaturcara HTML untukmenghasilkanBanner, Frame dan Menu 


	MuridmembinaBanner, Frame dan Menu dalamaturcara HTML

SesiAmali: muridmembinaBanner, Frame dan Menu dalamaturcara HTML


	

	MINGGU 29
KUMPULAN A

23 OGOS – 27 OGOS 2026
KUMPULAN B
24 OGOS – 28 OGOS 2026

	
	4.2.5 Membinapautanteksdanimejdalamaturcara HTML. 


	Muridmembinapautanteksdanimejdalamaturcara HTML

SesiAmali: muridmembinapautanteksdanimejdalamaturcara HTML


	

	KUMPULAN A

30 OGOS – 3 SEPTEMBER 2026
KUMPULAN B
31 OGOS – 4 SEPTEMBER 2026

	CUTI PENGGAL 2
	
	
	

	MINGGU 30
KUMPULAN A

6 SEPTEMBER – 10 SEPTEMBER 2026
KUMPULAN B
7 SEPTEMBER – 11 SEPTEMBER 2026

	
	4.2.6 Menulisaturcarauntukmemasukkanimejdalamaturcara HTML. 


	Muridmemasukkanimejdalamaturcara HTML

SesiAmali: muridmembinaimejdalamaturcara HTML


	

	MINGGU 31
KUMPULAN A

13 SEPTEMBER – 17 SEPTEMBER 2026
KUMPULAN B
14 SEPTEMBER – 18 SEPTEMBER 2026

	
	
	
	

	MINGGU 32
KUMPULAN A

20 SEPTEMBER – 24 SEPTEMBER 2026
KUMPULAN B
21 SEPTEMBER – 25 SEPTEMBER 2026

	
	4.2.7 Menghasilkanpull down menu melaluiaturcara HTML. 


	Muridmembinapull down menudalamaturcara HTML

SesiAmali: muridmembinapull down menudalamaturcara HTML


	

	MINGGU 33
KUMPULAN A

27 SEPTEMBER – 1 OKTOBER 2026
KUMPULAN B
28 SEPTEMBER – 2 OKTOBER 2026

	
	
	
	

	MINGGU 34
KUMPULAN A

4 OKTOBER – 8 OKTOBER 2026
KUMPULAN B
5 OKTOBER – 9 OKTOBER 2026

	
	4.2.8 Menghasilkanruangkomenmelaluiaturcara HTML. 


	Muridmembinaruangkomendalamaturcara HTML

SesiAmali: muridmembina tags dalamaturcara HTML

a) 
	

	MINGGU 35
KUMPULAN A

11 OKTOBER – 15 OKTOBER 2026
KUMPULAN B
12 OKTOBER – 16 OKTOBER 2026

	
	
	
	

	MINGGU 36

KUMPULAN A

18 OKTOBER – 22 OKTOBER 2026
KUMPULAN B
19 OKTOBER – 23 OKTOBER 2026

	
	4.2.9 Mengesansebarangralat yang berlakudalamaturcara

HTML yang dibina. 


	Muriddikehendakimembuatujiandanmengesanralat yang berlakudalamaturcara HTML yang telahdibina


	

	MINGGU 37
KUMPULAN A

25 OKTOBER – 29 OKTOBER 2026
KUMPULAN B
26 OKTOBER – 30 OKTOBER 2026

	
	
	
	

	MINGGU 38
KUMPULAN A

1 NOVEMBER – 5 NOVEMBER 2026
KUMPULAN B
2 NOVEMBER – 6 NOVEMBER 2026

	
	4.2.10 Membinalamansesa

wanginteraktif yang memaparkan

Banner, Menu, Ruangan Komen, 

Frame danPull down menu

	Membinasatulamansesawangpengajaran yang mengandungi:

b) Banner, Frame dan Menu

c) Pautanteksdanimej

d) Mengunakan pull down menu

Menghasilkansaturuangankomen
	

	MINGGU 39
KUMPULAN A

8 NOVEMBER – 12 NOVEMBER 2026
KUMPULAN B
9 NOVEMBER – 13 NOVEMBER 2026

	
	
	
	

	MINGGU 40
15 NOVEMBER – 19 NOVEMBER 2026
KUMPULAN B
16 NOVEMBER – 20 NOVEMBER 2026

	
	
	
	

	MINGGU 41
KUMPULAN A

22 NOVEMBER – 26 NOVEMBER 2026
KUMPULAN B
23 NOVEMBER – 27 NOVEMBER 2026

	
	
	
	

	MINGGU 42
KUMPULAN A

29 NOVEMBER – 3 DISEMBER 2026
KUMPULAN B
30 NOVEMBER – 4 DISEMBER 2026

	
	
	
	


